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ACROBAT TIPS 
 

Adding New Text in Acrobat 
To enable the typing of after-thoughts into a saved PDF document. 

 
1. Tools � Advanced Editing � Touchup Text Tool 

 

 
 

2. Move cursor over the exact area where the new text will appear centered. 
3. Press <Crtl> & Click on this spot. 

 

 
 
4. “New Text Font” pop-up appears. 
5. Choose the font face and orientation (vertical or horizontal text) <OK> 

6. Type in the new text. 
 
 
 
 
 
 
 

4 
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To Change Attributes of New Text 
7. Highlight the text to be changed. 
8. Right Click the mouse, select Properties from the options, choose font attributes. 

 

 

 
 

7 
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Changing Text in Acrobat 
 
Changing  Text 

1. Open the Acrobat document in PDF Writer mode 
2. Tools � Advanced Editing � Touchup Text Tool 
3. Highlight the text in the Acrobat document that you want to replace. 
4. <BackSpace> 

5. Begin typing, it should pick up the same font as the letters replaced but it will only allow new text to be 
entered on the same line. 

6. If you need to remove the text guidelines, click on the Hand Tool  on the top left horizontal toolbar and 

then click somewhere on the document. 
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Changing Fonts 

1. Click on the Hand Tool  on the top left horizontal toolbar 
2. Right click on the mouse and select “Allow Hand Tool to Select Text”  
3. Click on the document until the  turns into a normal cursor’s vertical line (I) 
4. Highlight the text you’d like to modify. 
5. Tools � Advanced Editing � Touchup Text Tool 
6. Right click over the highlighted text and select Properties.  

7. Edit your font characteristics on the pop-up screen (Note: only one font selection can be made for the 
entire selected text area). 

 

 
 
 

 
 

Turning a PDF into Word Text 
 
Open the PDF file 

File � Save As 
“Save as Type” choose Rich Text Format (RTF) 

 
To Move Embedded Images from the PDF document 

Advanced � Export All Images 
 

1 
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Deleting Pages in Acrobat 
Scroll through the document to find out which page(s) you want to delete. 

 
1. Document � Delete Pages 

2. Type in the range of pages to delete. 
3. Ok, Yes. 

 

Creating Bookmarks 
How to add bookmarks to an existing PDF: 
 

1. Click on the vertical Bookmark tab on the left side of the screen (this opens the sidebar that hosts the 
bookmarks). 

2. Click on the ”Select Tool” (usually the bottom nav bar at the top left side of the page (it looks like a 
capital “I” next to the hand/palm icon). 

3. Hold the mouse down and highlight the title of the section 
4. Edit � Add Bookmark 
5. The Bookmark automatically appears on the left nav barA 
6. Repeat to set the next bookmark. 

 

 

Setting/Removing Password Protection 
1. Document � Security 
2. Click Secure This Document to set password protection 
3. Click Remove Security Options for this document to remove it. 
 

 

 

2 
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Setting Document Defaults 
 
File � Document Properties 

Properties  to set: description, security, fonts, initial view, custom & advanced properties. 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Set Bookmarks 
 

1. Click the Select button (right of the Hand tool) 

2. Highlight the item to be bookmarked 
3. Edit ���� Add bookmark 

4. Repeat for remaining bookmarks. 

 

 

Default Bookmark View 
Set up a PDF file so that whenever it is opened, the bookmarks appear on the left panel. 

 
1. File � Document Properties 
2. Initial View – Show(tab) 
3. Bookmarks Panel & Page 
4. <OK>. 
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EXCEL TIPS 
Sharing and Tracking Edits in Excel 
To Create an Open document to be shared and tracked: 
 

Tools � Protection 
Protect and Share Workbook  

 Sharing with track changes 
<Save> 
 

Tools � Track Changes 
 Highlight Changes 

  When: All 
 Who: Everyone 
 Highlight changes on screen 
 List changes on a new sheet 

<Okay> 
 
To shut off this feature: 

Tools � Protection � “Unprotect Shared Workbook” 
Tools � Share Workbook  � Select “Editing” tab 

 Allow changes9 (delete the checkmark) 
 
 
 

Removing All Manual Page Breaks 
To remove all manual page breaks from a document to start over fresh. 

 
Right Click any cell 
Select “Reset All Page Breaks” 
 
 

 
 

Drop Down Lists 
To modify a cell so that, when it’s selected, a vertical drop down menu of possible choices appears.   
 
Making the Source List 

1. Select a cell to add an interactive Drop-Down List. 
2. Next, find an inconspicuous spot at the end of the document to create the data source that your 

pull-down list will draw from. 
3. Enter the data; one option per cell, all data in the same vertical column. 

Making the Connection 
4. Go back to your interactive cell and select it. 
5. Data � Validation (the “Data Validation” screen appears) 
6. Select “Settings” from the top tab. 
7. In the Allow pull-down box, pick “List” 
8. Click the icon on the right side of the “Source” box 

9. Use the mouse to lasso the range of items you’d like to have in your pull down. 
10. Click on the icon on the right side of the Data Validation pop-up.  <Okay> 
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White Space in Black Cell Border  
This occurs when the normal cell overlaps a white-bordered cell. 
 

1. Select the perimeter of the White Cell, then: 
a. Right Click � Format Cells � Border Tab 
b. Choose Black from under Color 
c. Single click the line type from the “Style” table and single click where you want the lines to 

appear. <OK> 
 

2. Select the perimeter of the Regular Cell, then: 
a. Right Click � Format Cells � Border Tab 
b. Choose Black from Color, pick a line from the “Style” table, and re-apply the lines to the cell.  
c. <OK> 

 
3. Select the perimeter of the White Cell again, then: 

a. Right Click � Format Cells � Border Tab 
b. Reapply the White Border to the appropriate side of the cell by using the method described in 

step 1 (NOTE: after selecting the color white, the items in the Style table become invisible) 
c. <<OK> 

 

4 
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Feeding Cell Data Into Another Worksheet (In the Same Workbook) 
In the receiving cell, type    =TabName!$L$N 

 
Where: 

• Tab Name = the name of the original worksheet in the same workbook (tab at bottom of page) 

• !$L = where “L” is the letter of the cell of origination 

• $N = where “N” is the number of the cell of origination 
 

 

Protecting Cells From Editing 
1.  Click on the “select all button” (the cell above row “1” and to left of the “A” column) 

• Format � Cells � Protection (tab) 
o Check the “Locked” button  
o <Okay> 

 
2.  Highlight the cells you want users to be able to edit (hold <CTRL> for multiples) 

• Format � Cells � Protection (tab) 
o Uncheck the “Locked” button (these cells can be edited) 
o <Okay> 

 
3.  Tools � Protection � Protect Sheet 

• Enter Password 
o Click only “Select  locked cells”  and “select unlocked cells” to allow others to click on all 

specific cells, but only make edits in the unlocked cells. 
o <Okay> 

 

4. Unlock = Tools � Protection � Unprotect Sheet 
 
 

Locking the Entire Workbook from Editing 
• Tools � Protection � Protect Workbook 
 

 

Finding Merged Cells Embedded in a List 
1. Create a new column. 
2. Type the word TEST in the first new cell, then copy to all remaining cells in the new column. 
3. By scanning down this column now, the merged cells should be obvious. 

 
 

Limiting Cell Character Content  
Limiting the number of characters entered into a specific cell. Good for limiting long-winded writers. 
 
Data � Validation  

Settings � Validation Criteria 
Allow: “Text Length” 
Data: “Less Than” 
Maximum: (number of characters – not words – you do not want to exceed). 
 

NOTE: 225 characters = approx. 40 words 
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Blank Background (On a Worksheet) 
 
To remove the excess cells outside of the perimeter of a table (replacing them with a solid gray background). 

 
1. Select the first empty column to the Right of your table.  
2. Hold the mouse button down as you drag the cursor all the way to the right until you reach Cell IV. 

Release the mouse button. 
 
 

        
 
 

3. Right click and select “hide” from the pulldown menu. 
4. Select the entire column A and keep selecting to the right until you reach the end of your table.  
5. Format � Cells � Patterns (gray). 
 
 

 
 
 
 

1 2 

3 

4 5 
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6. Next, select the area to be printed 
7. Format � Cells � patterns (white) 
 
 

      
 
 
 

Adding Pictures to a Header/Footer  
 
To add a logo or other emblem to the header and/or footer of every page. 
 

1. File � Page Setup � Header/Footer Tab � Custom Header 
 

  
2. If “&[Picture]” is there, then delete it and anything else in that box. 
3. Click in another box (left right or center) and then click back in the box you’d like to put the picture in. 

 

6 
7 
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4. Select Insert Picture button (2

nd
 from the right) 

5. Select a picture/image 
6. Click “Insert”  <Okay>  <Okay> 
7. File � Print Preview 
 

 
 
 

Removing a White Dot from a Cell Border 
When two cells share a common border and one cell’s border is in a white font (white spot missing) 
 

1. Select the perimeter of the white cell and change the borders to black. 
2. Open the regular cell, right click and re-add the black borders.  
3. Goto the former white cell and add the white border back. 

 
 

Adding an Ampersand (&) Into Header Text 
When the ampersand symbol (&) does not appear in the Header text (type in “M&G” and it appears as “M G”) 
 

1. Type in the word “and” in place of the symbol (&) 
2. In the Header, Word automatically changes the word “and” to the symbol “&”. 

3 

4 6 
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Excel Screen Grab Into A Word Doc (Via Fireworks) 

Create the Document in Excel 
� Go under View ���� Zoom and increase/decrease the document size so it entirely fits on a single screen 

(also try View ���� Full Screen if you need an extra inch). 

� Make sure the cursor and/or the highlighted cell(s) do not appear on the section of the document you 
wish to copy. 

� Press the Print Screen (Prnt Scrn) key (usually found to the right of the F# keys) 

 

Open Fireworks 
� File ���� New      <Okay> 
� Right Click ���� Paste (an image of your Excel document is now in Fireworks) 
� In the Left Tool bar select Crop (two squares down in the left column, click & hold on the little arrow in 

the square and select the Crop tool) 
� Line up the Crop Pointer with one corner of the diagram, click and hold, dragging the crop to the 

opposite corner of the image, then release.  Hit Enter and the outlying areas are deleted. 

� Use the Erase Tool (nine squares down in the left column) to shave any close edges. 
� File ���� Export Wizard    Continue 
� Select A Desktop Publishing Application for Word (the Web for an online doc). Continue. 
� Exit     <Okay> 
� Under Options/Format, select GIF (from the pulldown menu) 

� Directly above the Export Button, click the box with two cells (this enables you to view two hypethetical 
versions of your document). 

� Under Options/Format, select JPEG (from the pulldown menu). One of the hypethetical documents is 

what the image would look like saved as a GIF, the other is what a JPEG will look like. Adjust the 
controls for each to find the best quality picture necessary with the smallest file size.   

� Decide if you want to save the GIF or JPEG, then select your choice and click the Export button. 
� Enter a File Name and navigate to the folder you wish to save the image to.  <Save>. 

 

Open Word 
� File ���� New 
� Insert ���� Picture ���� From File (Navigate to your GIF or JPEG image and highlight it). 
� Insert. 
� Save your Word document. 
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Tidbits 

If an Entire Row Disappears  
If an entire row disappears off the Excel Worksheet and it looks like someone went in and accidentally deleted it. 

 
� Windows � UNFreeze Panes 

 

 Overtype 
Overtype makes your keyboard type over text you’ve already entered and is usually turned-on by accident 
through sloppy keyboard use. To shut off Overtype, click on your Keyboard’s Insert Button on the Right 

top/middle of your keyboard. 

 

Single Line Spacing 
A Single line space is created by entering Alt/Enter.  
 
 
 

Manually Indenting Bullets  
Indented bullet items are done by entering Alt/Enter for each item, followed by three single spaces, a “-“ bullet 

and an additional space followed by the bullet text.  Overhanging text caused by bullet additions can be manually 
adjusted by placing your cursor before the last visible word on the line (in the Text Entry Box at the top) and 
doing Alt/Enter, followed by the necessary spaces to bring the new row into line below it. 

 
 

Printing Everything  
To print all WorkSheets together, Goto the File/Print pulldown, click the radio button for Entire Workbook and 

print. 
 
When Entire Workbook is selected, all Worksheets print out with page numbers consecutive and uninterrupted 

from the first page of the first sheet to the last page of the last sheet. However, WorkSheets may printout out of 
order, but their page numbering will be correct. Always check the page numbering. 

 
Worksheet # Worksheet #1 Worksheet #2 Worksheet #3 
Entire Worksheet 
Printout 

Page #1-5 Page #6-7 Page #8-14 

Active Sheets (one 
worksheet at a time) 
Printout 

Page #1-5 Page #1-2 Page #1-9 

 

 
 
Fitting Print On a Single Page 
To automatically fit an entire Worksheet onto one printed page, goto File/Page Setup and select the radio button 
for Fit to: and make sure it says “Fit to: 1 pages wide”.  View before you print to make sure the words will be 

large enough to read.  
 
To change back to normal, goto File/Page Setup and select the “Adjust to:” radio button and change to  
“Adjust to: 100% normal size”. 
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Editing Cells 
To edit text already in a cell, first select the cell, click in the Text Entry Box found just below the horizonal top 
toolbar and type. Selecting and typing directly on the cell will first delete all existing text in that cell. 
 

Free-Text Cells 
When a lot of text is entered into an Excel cell, the cell does not always automatically expand to compensate 
and, as a result, “swallows” the bottom lines.  Check the text entry box under the tool bar. If text in the entry box 
does not match the last lines in the cell below, then manually expand the cell by dragging the bottom down.  
 
If the last lines are cut-off by the bottom of the cell, and resizing the cell doesn’t help, place the cursor in the text 
entry box before the last viewable word (that appears in the actual cell below) and do an Alt/Return.  This makes 

a hard carriage return that should enable the missing text to appear on the next line.  

 

Custom Cell Colors 
If you’re not satisfied with standard colors, the following explains how to fill the cells of your Excel document with 
customized colors: 

 
1. Tools � Options  
2. Color tab (click on the color cube that you want to over write) 
3. Modify � Standard (hexagonal colors) or Custom (RGB values) 
4. <Okay>. 

Note: the changes do not appear on other users’ computers. 
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Moving Worksheets 
Individual Worksheets can be deleted from a WorkBook or copied or moved to another WorkBook.  Click on the 
WorkSheet tab at the bottom of the page and then right-click on the tab.  Select your action from the popup.  
Selecting Move/Copy enables you to move an individual worksheet from one Workbook to another (Move 
erases the original, Copy makes a copy and moves it to the new Workbook, preserving the original).  NOTE: If 

an individual text cell in the Worksheet you’re moving has more than 255 characters, the move or copied version 
will truncate the text at the 255

th
 character; therefore you’ll have to copy & paste these long cells manually, on an 

individual basis. 
 
 

Changing The Default Comment (Pop up) 
When you add a comment, the text that automatically starts off the comment is the Default Comment Text 
(usually your name or company). To change this default to something else, follow the following path: 

• Tools > Options > User Information > Name: (Change to default name desired) 
 

 

Freezing Header Rows & Columns 
With long documents (more than one screen) the column heads (and left rows) can be “frozen in place.” This 
enables users to still view column and row labels – even if they are several pages into the document.  
 

1. Click on the CELL below the joint where you want the split to go. 
2. Pull down Window � Freeze Panes. Now, when scrolling, the header will always remain at the top 

(and/or left) of the screen. 
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FRONTPAGE TIPS 
 

Indenting Text Inside a Cell 
To create a gap between words and the walls of a cell.  
 

1. Leave the cursor in the cell that’s to be edited 
2. Format � Borders & Shading 
3. Select the Borders tab 
4. Under the “Padding” title, enter numbers into the four text boxes (near the bottom of the page). 

5. Type text into the cell and see if the buffer zone is big enough.  
 
 

Making a Template 
Creating a standard page to start from. 
 

1. File � New � New Page 
2. Click Blank Page (for a new page) or From Existing Page (from an already created page) and 

click Create New 

3. Make changes 
4. File � Save As � FrontPage Template. 
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INTERNET EXPLORER/WINDOWS 

TIPS 
 

Removing Previous Searches from Google 
If you enter a letter into Google search and a bunch of previous searches automatically pop up, this erase all 
previous searches. However, searches created afterwards will begin to accumulate again. 

 
1. Internet Explorer � Tools tab � Internet Options 
2. Select Content tabl 
3. Under Autocomplete (or Use Autocomplete for ) section: 

a. Click on the “Settings” biutton 
b. Unselect “Web Addresses” 
c. Unselect “Forms” 
d. Click <OK> 

 
 

 
 

Windows “Blocked9” Popup Appears (verify this) 
To eliminate the annoying popup messages that appear on the lower right corner of the screen 
announcing something stupid and interrupting your session. 

 

1. When a popup appears… 

2. Right click on the small icon it is attached to 

3. Click on “run blocked programs” and then a box will appear 

4. Click on the box that says “stop this message coming up” 

 

 

Remembering Passwords in IE 
To get IE to remember commonly used passwords. 

 

1. Tools ���� Internet Options ���� Content ���� Auto Complete 
2. In “Use Autocomplete for” check all the boxes 

3. Tools ���� Internet Options ���� Security Tab 
4. Custom Level button 

5. Scroll to the bottom of the list 

6. Select radio button for “Automatic Logon with Current Username and Password” 
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HTML/CSS TIPS 
 

CSS Font Control 
To create a new HTML tag that will convert text to the specified color, size, font type, etc. 
 

<Head> 
<STYLE TYPE="text/css"> 
<!-- 
H2 
   {color:blue; 
   font-size:86pt; 
   font-style:bold; 
   font-face:georgia;} 
--> 
</STYLE> 
</Head> 

 
 
 

Rollover Text Links 
Enables text to glow when the cursor is rolled over it or clicked on it (match up to Spotlight example) 

 
<Head> 
<h4> 
 
<Body> 
 
<H4> <a href=”URL”> 
<Span Style= “Text Decoration: none”> 
Launch Phrase 
</Span> </a> </h4> 

 
 

Target Practice 
Determine what kind of box the new page will open into after a hyperlink has been clicked on. 

 
<A TARGET=”_blank” HREF=”http://www.wengal.com”>Wengal Home</a> 

 
o _blank = opens into a whole new window 

 
o _self = same frame 

 
o _ top = whole page 

 
o _parent = parent frame
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OUTLOOK TIPS 
 

Changing Your Email Signature 
The following technique enables users to create, edit, or delete the content/format/style of the 
salutation/signature (that automatically appears at the end of every Outlook email message): 
 

1. Tools � Options.  
2. Click the Mail Format tab and click on Signature Picker button. 

3. Add a new signature, edit existing signature, or delete existing signature. 
 

 
 
 
 
 

 

Taking Back an Email (Recall) 
Discovered your message was mailed to the wrong person or a major typing error?  Here’s how to keep people 
from reading it. 
 

1. Go to “Sent” items 
2. Double click on the message you want to recall 
3. Actions � Recall This Message 
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Time Delivered Email 
Write an email and set it to mail tomorrow morning or next week, or next year. 
 
Double click on your email message, then: 

1. Click “Options” from the pulldown “Nav bar” (not from under “Tools”) 
2. Under “Delivery options” click: 

 Do not deliver before [Date & time] 

 

Voting Buttons 
Recipients can respond back to an email by clicking an “agreed” or “rejected” button. 
 
Double-click on your email message (Outlook takes up the entire screen) 

1. Click “Options” from the pulldown “Nav bar” (not from under “Tools”) 
2. Select “Voting and Tracking Options”  

Use voting buttons 
Request delivery receiptA  

 
 

Tasks: Changing Order Within a List 
1. Tasks � View 
2. Current View � Customize Current View 
3. Group By � Clear All � <Okay> 
4. Sort � Clear All 
5. <Okay> � <Okay> 

6. Click, hold, and drag items to the new locations on the list. 
 

 

Tasks: Freezing List Order 
1. Tasks � View 
2. Current View � Customize Current View 
3. Group By � Clear All � <Okay> 

4. Sort tasks in the order you like 

5. Actions � Save Task Order 
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Creating a New Distribution List 
In a heavily secured corporate environment, you can still go in and create your own personal distribution lists.  

 
1. Create a “New” blank email. 
2. Click the “To” button (with the open book icon next to it) and the “Select Names” screen pops up. 
3. Under “Show Names from the: “ drop down box, select “Outlook Address Book � Contacts” 

 
 

   
 
 
 

4. Click on the “Advanced” button, then select “New” from the pull-down. 
5. Select “New Distribution List,” then <OK>. 

 
 
 
 
 

3 

2 

4 

5 
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6. Click the “Select Members” button and select who you want on your list. <OKAY> 
7. Enter a name under “Name:” 

 
 

 
 
 

8. Click on the “Save and close” button 
 
 
 
 
To Use the New Distribution List 
9. Highlight the distribution list 
10. Click the “To” button, then <OK> 
11. Click on the “+” symbol to break the list down into individual member names. 
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POWERPOINT TIPS 
 

Adding Page Numbers 
 

1. Open the Master Slide (View ���� Master ���� Slide Master) 
2. Click on the Number Area in the bottom center of the Master Slide’s second page (select the box – don’t 

highlight anything) 
3. Click on Insert ���� Slide Number 
4. Click the Slide Number checkbox under the Slide tab 
5. Click the Page Number checkbox under the Notes and Handouts tab 
6. Close Master View 

 
 

Converting Existing PPT to a New Template 
 
1. Print out the slide show (for reference) 
2. File ���� Save As 

a. Change file ‘type’ to “Outline/RTF” format 
b. Save 

3. File ���� Close (to close the original PPT show) 
4. File ���� New 

a. Select the new template 
5. Insert ���� Slides from Files 

a. Browse to the original PPT’s folder 
b. Under “Files of Type” at the bottom of the prompt page, pull down and select the “All Files” 

type. 
c. Double click on the .RTF version of the original slide show 
d. Click on “Insert All” (and make sure “keep source formatting” button is off 

e. Close the popup page 
6. Review the newly formatted PPT slide show and correct any formatting problems 

a. For example, the Title page info usually appears on the page following it 
 

Align Text Box 
 
To consistently line up the text on the left side margin of each slide 

Click on the textbox 
Format � Placeholder (‘Format AutoShape’ box appears) 

 
Click on the Text Box tab: 
 Text anchor point = TOP 
 Internal Margin: 

 Left:  0.1   Top:  .05 
 Right:  0.1  Bottom:  .05 
 Word wrap text in AutoShape 
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Line Spacing 
1. Highlight the text that will be modified. 
2. Format � Line Spacing 

a. Line Spacing = single space, double space, etc. 
b. Before Paragraph = Space before each text selection 
c. After Paragraph = empty space after each text selection 

 

 
 

 

Omit Background Object (from one slide only) 
 
To Delete Images from Background 

Format � Background 
 Click checkbox  ‘Omit background graphics from master’ 

Click “Apply” (Apply to All to change entire document) 

All background graphics (good & bad) are deleted from the slide 
 

To Reinstall Good Graphics: 
View � Master � Slide Master 
Depress Shift key and click on the object you want to copy 
Press Ctrl C (to copy graphic) 
In the “Slide Master View” popup menu, click “Close Master View” (to return to original slide) 
Click mouse where you want the image to go, click Ctrl-V (paste) 

 
Layering Graphics 

Click on small black down arrow on the “Draw” button (on lower left side of screen). 
Select “Order” from the pull-up menu, then select “in front” or “in back” to move this graphic of 

other graphics. 
 

 

1 

2 

a 

b 
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FootNotes in PPT 
To eliminate the annoying popup messages that appear on the lower right corner of the screen 
announcing something stupid and interrupting your session. 

 

1. Goto Slide (unselect lasso)  

2. Insert ���� Textbox 
3. Click to place, type/paste footnote content. 

 

Adding Metadata Info 
To enter info into PPT shows to identity important information such as dates, reviews, and search 
information.  

 

1. Goto File ���� Properties 

 

 

Summary 
(Manually Enter Data) 

Statistics 
(Automatic Generated Data) 

Custom 
(Manually Enter Data) 

Title (from first page) Slides (# of slides) Editor 

Subject (topic) Paragraphs (# of paragraphs) Client 

Author Words (word count) Data Completed 

Manager Bytes (file size) Department 

Company Notes (total # of notes pages) Owner 

Category Hidden Slides (# of hidden slides) Source 

Keywords (search words) Multimedia  

Comments Presentation Format (file type)  

Hyperlink Last Saved By (last person to make changes)  

Save Preview Picture 
(checkbox) 

Revision Number (complete number of edits)  

 Total Editing Time (dedicated to this project)  
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WORD TIPS 
 

Font: Squeezing Text (Text Spacing) 
The following technique can help with layout and pagination. Condensed text enables sentences to be 
squeezed to fit within a single line or page: 
 

1. Highlight the text you wish to condense 
2. Format � Font 
3. Click on the Character Spacing Tab 
4. Under “Spacing” select “Condensed” (from the pull down menu)  
5. Under the corresponding “By” select the point level to which you want to squeeze your text 

(Example: Size 0.2pt  compression vs. Size 1.0pt compression) 
 

 
 

 

Font: How to Hide Review Changes (When First Opening the Doc) 

1. In the “Reviewing” toolbar, change “Final Showing Markup” to “Final” 
2. Remove all checks under “Show” (except final) 
3. Tools � Options � Security 
4. Remove Check from “Make Hidden Markup Visible When Opening or Saving” 
5. <Okay> 
6. Save document with a NEW file name. 
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Font: Removing Horizontal Lines  
Horizontal lines add a nice aesthetic touch to most Word documents. However, those lines sometimes defy 
every effort to delete them. Type three or more hyphens or underlines in a row – immediately followed with a 
hard return – will automatically generate a horizontal line. 

From Text 
To remove horizontal lines from regular text, try the following: 
 

1. Goto View � Web Layout 
2. Highlight the Horizontal lines 
3. Right click and select “Cut.” 

From Headers/Footers 
To remove horizontal lines from a header/footer, try the following: 

 
4. Goto View � Header/Footer 
5. Select “Page Setup” (open book icon) from the Header/Footer toolbar. 
6. Click the “Layout” tab; then click the “Borders” button. 
7. Click the “Borders” tab; then click on “None” under the “Setting” column. 
8. Click <Okay>. 
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Header/Footer: No Front Page Numbers 
Most formal documents have a separate title page, followed by a table of contents. Neither of these pages 
should be numbered nor appear in the table of contents. To ensure this, execute the following steps 
BEFORE you begin your formal document: 
 

1. Goto File � Page Setup � Layout tab 
2. Under Section Start select “Continuous” from the pull down menu 
3. Under Headers and Footers select “Different First Page” 
4. Under Apply To select “Whole Document” 
5. Click <Okay>. 

 
 
 

 
 
 

 

 

Header/Footer: First Page Custom  
� Start document. 

� Immediately go to View ⇒ Header & Footer ⇒ Page Setup ⇒  
select “Different First Page” and “Whole Document”. 

� Type in your first page. 
� When you get to the second page, immediately go to the header (on page 2), delete the first page 

header, then add the new header. 
 
 
Problems 
� Section Breaks will cause the first page header to reappear in the middle of second page headers. 

Solution: You can see Section Breaks by going under View ⇒ Normal.  Highlight and delete them. 
� Traditional Page Breaks will not cause header damage. 
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Header/Footer: No-Shows in the Table of Contents: 

1. Highlight the subhead. 

2. Format  Paragraph.  

3. Make sure Outline Level is at Level 1 or 2. 

 

Header/Footer: Continuous Page #s between Two 
Sections 

• Double click on the header and/or footer. 

• Highlight the page number inside the header/footer. 

• Click Format Page Number icon (3
rd icon

 from the left) 

• Click on “Continue from Previous Section” then click <Okay> 
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Header/Footer: Different Section Titles  
 

1. Double click over the Header or Footer area of the new section 
2. Click the “Page setup” button on the Header and Footer floating toolbar. 
3. Click on the Layout tab; under the “Preview” section answer the “Apply To:” prompt with “This 

point forward”  <Okay> 
4. Close floating toolbar. Reopen floating toolbar. 
5.  “Same as Previous” appears at the top of the Header/Footer border – this must be removed. 
6. Click once on the “Link to previous” button on the middle right of the floating toolbar (the “Same 

as previous” text should disappear from the top of the header/footer box. 

7. Manually type in the sectional material in the header/footer space.  
8. Click out of the header/footer box and review the section to see if it worked. If so, repeat for the 

next section. 
 
 

 

 

 

 

 

 

TOC: Page Numbering 
 

Open New Word Template Document 
DO NOT click “Separate First Page” under Page Setup � Layout! 
 

• On the first page, do an Insert ���� Break, then select Page Break ���� <Okay> (to goto the TOC 

page) 

• Do another Insert � Break, and click  Section Break Types/New Page � <Okay> 

• Click View � View Header and Footer 

• Insert your cursor in the “Section 2” heading (on top of page 3) 

• In the top right of the header, it should say Same as Previous, if so, click on the Link to Previous 
icon in the header/footer toolbar. This will isolate the new section from the title/TOC section.  

• Do the same for the footer on page 3.  

• Insert automatic Page number on page 3. 

• If “Page 3” appears, goto the header/footer toolbar and click on Format Page Number (3
rd

 from the 
left). Click the manual radio button for page number and enter 1. 

• Now you have the first two pages without a header/footer followed by a second section with normal 
page numbers. 

 
 
Special Note I have no idea how to get the “Page 1 of 3” tool to work under this technique. Stick with just 

listing “Page 1.”  
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TOC: Editing the Format 
 
Insert � Reference  
 Index and Tables � Table of Contents � Modify 
 
Select Heading Levels to edit (TOC1, TOC2, etc.) 

Modify 
Style based on: [PICK ONE] 

<Okay> � <Okay> � <Okay>  
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VISIO TIPS 
 

 

Moving Text Blocks Attached to Arrows 
 
Double click on the text block in order to highlight the text inside. 

1. Select the “Text Block Tool” from the top nav bar 
2. Eight green squares magically appear around the text block 
3. Drag & stretch these squares to change the location of the text box on the arrow 

 
To be able to move the arrows: 

4. Click on the white arrow button on the top nav bar. 
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